
Intro to V8  

1.	 Introduction 
Information in this document is based on the following software versions: 
MicroStation V8 2004 Edition (08.05.02.35), Geopak 2004 Edition (08.05.02.35), 
and Office 2003 (with Office SP1). 

This document is intended as an introduction of this new software for T.D.O.T. 
Design Division users who are switching from MicroStation J (V7), Geopak 2001 and 
Office 97. Changes to current functions and many new functions are described, but 
not all changes are presented, in the following sections. 

General Enhancements 
•	 The maximum physical size of the DGN file is limited only by the disk space 

available. Some users may have run into this limitation when area patterning large 
areas. Extremely large files are not recommended since processing time for some 
procedures will increase dramatically. 

•	 There are no restrictions on referencing between 2D and 3D DGN files. It will no 
longer be necessary to convert Survey topo 3D DGN files to 2D in order to use 
the information with other plans 2D DGN files.  

•	 MicroStation V8 stores design coordinates in double precision floating point. The 
use of double precision floating coordinates allows for a high degree of accuracy 
and a working volume with each axis roughly 2 million times larger than the axes 
in V7. We will no longer have a problem maintaining bearings on short lines 
when they are extended. 
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Models 
A MicroStation V8 DGN file is composed of one or more models. A model is a 
container for elements. 

When you draw, or place elements, in a MicroStation DGN file, you are creating a 
model. A model can be either 2D or 3D, and is stored as a discrete object within the 
DGN file. It may be helpful to think of a DGN file as a box that can contain both 3D 
and 2D objects, or models, any of which you can view individually.  

Cell libraries are DGN files with models for each defined cell. Cells are automatically 
stored as individual models when created. 

When you first create a new DGN file from one of the seed files, this provides the 
empty container setup with a default model ready for you to create your design. If you 
use a 2D seed file, then the default setup is 2D, while a 3D seed file defaults to a 3D 
setup. 

Models in T.D.O.T. Design Division DGN Files 
The Default model will used for all DGN graphics except for cells in cell libraries at 
this time. We are maintaining our project DGN files as done previously with 
MicroStation J (V7). As the use of MicroStation V8 is incorporated into our work, we 
may find advantages in expanding the use of models.  

2




2.	 MicroStation Interface 

Status Bar instead of Command Window 
Status Bar in conjunction with Key-in window and Attributes tool bar replace the 
Command Window as used in MicroStation J (V7). 

Status Bar displays Command prompts and Messages on the left of the bar. In the 
center of the message area just to the left of the word “Type” shown below is the 
Message Center. Click on the bar there to open the Message Center dialog to review 
previous messages. 

On the far right of the Status Bar are several other fields with pop up menus when 
you left or right click on them 

Snaps	 Locks 
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Active Level, when you click on this field the Level Manager dialog is opened. 

When Selection Sets or Fences are active icons are shown: 

Selection Sets Fence Modes 

Dockable Menu Bar 
Un-Docked 

Docked at bottom 
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Mouse Control Preferences 

Includes several new options for mouse wheel. 

Right Clicking to customize Interface 
To hide or show a tool  
1.	 Open the tool box that contains the tool icon. 

2.	 Position the pointer within the tool box and right-click. 
A pop-up menu opens. Enabled tools are indicated with checkmarks. 

3.	 Choose the pop-up menu item for the tool you want to hide or show. 

Dialog Control Options 
Many dialogs now include column headers which can be turned on or off to control 
what is shown in the dialog. Right click on the header bar and choose the pop-up 
menu item for the column you want to hide or show 
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3. MicroStation Levels 

DGNLIB Files 
DGN level library files, TDOTmain.dgnlib & TDOTxsection.dgnlib are the main 
source for standard levels, level filters & text styles. T.D.O.T. Design Division DGN 
seed files have these settings imported into them from those files.  


 See document file CADDV8.pdf for further information. 


TDOTmain.dgnlib 

TDOTxsection.dgnlib 
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V7 Levels vs. V8 Levels 
The most notable change in MicroStation V8 is the expanded level structure. Several 
old MicroStation J (V7) levels have been expanded to multiple levels. This will allow 
more precise control on what is shown on our plans sheets as well as providing more 
flexibility when developing those plans.  

Most old V7 levels still contain the same type of data they did previously and as such 
are still included on the sheets where they were used in V7. One exception to this are 
the levels for profile graphics which are now on all new levels. A special level filter is 
provided that includes both V8 and V7 levels for profile graphics so that you do not 
have to move those graphics to their new levels. 

Level Manager 
Level Manager is used to manage level names, level filters and other level definitions. 
Users should use Level Display for general control of levels. That tool is described 
with some detail in the next section. Users may use Level Manager to control special 
level symbology settings. 

ByLevel Symbology 

MicroStation V8 provides ByLevel symbology to define symbology based on the 
level. The Attributes tool bar is shown below with ByLevel attributes set. 

In the Level Manager dialog switch mode from ByLevel to Overrides in order to set 
or use old style Level Symbology to supersede normal element displays. 
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Level Display 

Level Display mode 
Sets the operating mode for this dialog box 

View Display 	 Changes in the level display affect the chosen view in the active 
model. Recommended for general application. 

Global Freeze 	 Changes in the level display affect all views in all models in the 
open file. When Global Freeze is on, elements on the frozen levels 
are not displayed and cannot be printed (plotted).  

The Global Freeze setting also affects references. If a level is 
frozen, any references on it are not displayed, and cannot be printed 
or plotted. 

Global Display	 Changes in the level display affect all views in all models in the 
open file. 
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Properties 

Right click in dialog area near top. 

Target List 
Sets the orientation of the Level Display dialog box. The Target Tree is the DGN 
file list including the master DGN file and its reference files. 

Horizontal Sets the Level Display dialog box to display the Target Tree above 
the list box. 

Vertical 	 Sets the Level Display dialog box to display the Target Tree on the 
left and the list box on the right side. 

Merge Names 
When multiple targets are selected, only unique level names are displayed. For 
example, if 10 instance of the same level name exists that level name will only 
appear once. 

Link Tree Selection 
Links the actions of the Level Manager and the Level Display dialog box. 

Auto-arrange items 
If on, icons in the tool bar wrap when the dialog box is resized. 

Allow Docking 
If on, the next time you open the Level Display dialog box, it will be available for 
docking. 
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Additional Right Click Options 

Master DGN     Reference DGNs 

Levels area Level Header List 
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Levels Color Coding 

Green active level 

Black level display is on 

Background Gray level display is off 

Dark Gray level display is off in at least one view or file 

Dimmed Gray level is globally off 

Bold level contains graphics 

Not Bold empty level  

Level Filters 
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Using Level Filters for Level Display Control 

Using Level Filters for Level List Control 
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4. MicroStation Tools 

AccuDraw 
Temporarily disable from Primary Tools bar 

Prevent Auto Load from drop down option Settings>AccuDraw 

AccuSnap 
From the Status Bar Snap options, AccuSnap Settings opens 
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From Button Bar 

Great tool except in large crowds of graphics. To change settings from button bar, 
right click and choose Properties. 

Another function controlled with AccuSnap is Pop-up Info which displays element 
information when the cursor pauses over the element. 

In Automatic mode, AccuSnap must be turned on for pop up info to appear. In 
Tentative mode it appears whenever you tentative snap to an element. 

Right Click on the Snap button bar to control what snap options are shown. 
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Multi-Snaps 
This function provides the ability to do various types of snaps in a specific order. To 
change settings from button bar, right click and choose Properties. From the Status 
bar choose option MultiSnaps. 

Right click in the settings dialog to set order of snaps to be used. 

3 MultiSnap set ups are available for use, MultiSnap 1, MultipSnap2 & MultiSnap3 
from button  bar or Status Bar 

Pop-Set 
Used to make the tool settings dialog pop up when over the active command icon and 
then go away after time specified in its properties dialog. Green color indicates 
PopSet is on and red indicates that it is off. 

Right click over PopSet and choose Properties to set controls. 

Alternate Indicator Icons include + or – to show status as off or on. 
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Primary Tools 
Right Click on Primary Tools to control what icons are shown 

Pop-Up Dialogs are available from down arrows on Primary Tools. Dialog remains 
up as long as cursor does not pass across a view window which releases the dialog. 
Clicking on the regular command icon opens the dialog in the regular manner where 
they remain opened. 
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Reference Dialog 
Now includes all reference tools as icons at top of dialog. 

Hilite Modes 

None — Displays the reference without a dashed border or highlighting.  


Boundaries — Places a dashed border around the reference. 


Hilite — Highlights references. 


Both — Places a dashed border and highlights the reference. 


Nesting and other attachment settings 

To control display of nested raster references, click on the Display Raster References 
icon. 
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Attachment Modes: 

Interactive 	 To attach through the Reference Attachment Settings dialog 
box. Similar to the attachment procedure with MicroStation 
J(V7). Use this method when attaching saved views as 
references. 

Coincident 	 To align the reference with regard to design plane coordinates 
only 

Coincident – World 	 To align the reference with the active model with regard to 
both Global Origin and design plane coordinates. 

Attachment modes also include all standard view orientations such as Top for 2D or 
3D and Right, Front, etc. for 3D. 

Clip Boundary now includes option to clip with Element instead of Fence. 
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 Text Editor 
It is recommended that users not set text styles in the Tool Settings dialog when 
placing new text. When set in this manner, MicroStation only sets the color and the 
standard text size for 50 scale sheets. The correct weight and level are not set. 

Instead use the Text Styles Plus program which activates text styles and sets the 
active level, color and weight. This is described in the T.D.O.T. Interface section of 
this document. 

Text Editor Window Styles 
Word Processor The word processor is the default format. Recommended for use. 

Dialog Box The window format as used in previous versions of MicroStation. 

WYSIWYG The WYSIWYG Quick Edit window. Includes keypad in dialog 

Key-in The Key-in window. 

Editing Text 
Text string is marked when editor opens. To completely replace simply start typing. 
Otherwise use cursor to click in area for change. 

Data point in view to apply changes. This data point can select another text element 
for editing. 
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The Word Processor style of text editor includes a Spell Checker. Just click on the 
ABC icon at the top of the dialog. 

Right click options within text editor window. 
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Change Element Attributes 

Method sets whether you want to Change or Match and Change selected element 
attributes. 

It is no longer necessary to reset the current active attributes to change an element’s 
symbology, etc. but those settings can still be used if desired.  

If Use Active Attributes is on while using the Match/Change mode the active 
attributes are changed to the element’s attributes selected to match. 

Match attributes “fromcursor” 
The new keyword fromcursor can be used with the match key-in command to match 
any or all of an existing element’s attributes by merely hovering the pointer over the 
element and entering the key-in. To best take advantage of this enhancement, assign 
key-ins of this form to a function key. AccuSnap must be enabled to use these 
keyins. 

1.	 With AccuSnap enabled, hover the pointer over the element whose level and 
attributes you want matched. 

2.	 Key in MATCH ELEMENT FROMCURSOR.  
All element attributes are changed to that of the highlighted element. 

Copy Element 

Command now includes number of copies option. Distance from original controls 
spacing of copies. If fences mode is set to Stretch, Stretch Cells control is enabled. 
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Move\Copy Parallel 

Mode 
Determines the method by which the gap created, by moving two connected elements 
to a parallel location, is filled such as with Line Strings or Complex Chains. 

Miter 	 Extends or shortens connecting segments while maintaining the angle 
of their connections. 

Round 	 Fills the gap with a rounded arc between the two moved elements. 

Original	 Fills the gap in the same manner as the MicroStation J (V7) 
implementation of this tool; the resulting element is the same type as 
the original element.  

For some element types — for example, ellipses — Original does not 
produce a true parallel offset. With an ellipse Miter or Round results in 
a B-spline, a true parallel offset, rather than an ellipse. 

Distance 
If on, sets the distance to move. 

Define Dist(ance) 
Clicking the Define Dist button lets you define the distance to move, graphically with 
two data points. When you have defined the distance, the Distance setting is turned on 
automatically and the defined distance value is displayed in its field. 

Use Active Attributes 
If on, the moved or copied element takes on the active attributes.  


If off, the moved or copied element retains the attributes of the existing element. 
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5.  TDOT Interface 
New MicroStation visual basic applications have been developed to provide access to 
cells and to perform other customized functions. These programs and other functions 
now available from MicroStation & Geopak replace the old T.D.O.T. Design 
Division tutorial system and the UCM programs used to run it. 

Note that with V8 this interface is set up separately from the default MicroStation 
interface so to use it , go to MicroStation Manager and set the Interface in option at 
bottom to TDOT. 

T.D.O.T. Drop Down Menu   
This menu provides a quick way to access most of the Design Division’s customized 
functions. Options now access new MicroStation visual basic applications. 
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The following sections describe some of the programs available through the TDOT 
interface. See document TDOTDesignDivisionPrograms.pdf for information on all 
functions. 

TDOT Design Division Toolbox 
This program\dialog provides access to many of the tools, commands and functions 
used most often by T.D.O.T. Design Division personnel.  

It is an alternative to access of them through the TDOT interface drop down menu or 
Geopak's D&C Manager. Essentially this tool box is a combination of the old Tools 
and Main tutorials used in MicroStation J (V7). 

The TDOT Design Division Tool Box is available from MicroStation menu bar at  
T.D.O.T.>Tools>Design Division Tool Box 

or from Geopak’s D&C Manager at  
Drafting Standards > Tools > Design Toolbox 
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Cell Dialogs 
All cell dialogs are in the same basic format, a cell pick list by description on the left 
with a viewing window on the right. At the bottom of the dialog are the Cell Tools 
option and other special programs that might be needed or used in conjunction with 
these cells. A “window shade” minimize button is located on the upper right. 

Scroll down the cell list and pick any cell. That cell is made active and the Place Cell 
command is started. Adjustments can be made for angle and scale in the tool Settings 
dialog prior to placing cell as needed using these basic controls. 

Click on the Cell Tools button in the cell dialog. This opens MicroStation’s Cell 
Tools tool box 

These are special cell placement tools including: 

Place Cell & Rotate 	 places cell by data point with dynamic rotation 
(includes default angle used if a Reset is given) 

Place Cell On & Rotate 	 places cell on an element with dynamic rotation 
(includes default angle used if a Reset is given) 

Place Cell On 	 places cell on an element at specified angle  
(cuts hole in element) 

Place Cell Along 	 places cell along an element at specified spacing, offset 
and angle 
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Signs 
Sign face cell dialogs are somewhat further customized from regular cell dialogs. Cell 
list also includes various permanent & temporary sign symbols near the end 

A command button and keyin fields are provided to place sign face with associated 
optional graphics including a text label, leader line and sign symbol (single post & 
face). 

Option for placement as Permanent or Temporary sign is given which controls the 
level and text label type which is used. As a permanent sign, sign number text is 
placed with enclosing ellipse and as a temporary sign, sign name and optional size is 
placed. All text values are displayed in keyin fields allowing adjustment by the user if 
needed. When a sign number is placed with permanent signs, the value is 
automatically incremented by one with each placement. All text in keyin fields can be 
altered on the fly during placement.  

A command button is provided to place permanent sign # only. 

Since English sign face cells are used in metric files, a keyin field is provided which 
shows the desired Metric Plot Scale. This value is used to alter the active scale 
temporarily so that sign faces are placed at the correct size. When the Cancel button is 
clicked to close the dialog, the active scale is reset in the DGN file to match the 
specified plot scale. 

The Highway Route Sign Cells dialog also includes a text entry field to automatically 
fill in the route number on the sign face when placed with the Place Sign Face with 
… command. 

Signs are available in the following groups: Blank Signs, Construction, Highway 
Route, Regulatory, School, Tennessee and Warning. Some signs are found in more 
than one group to accommodate the users work 
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Text Styles Plus 
This program activates text styles and sets the active level, color and weight. The 
current active scale is shown with a keyin field to reset as needed. Scale is used to 
control the text size in conjunction with the standard size associated with the text 
style. 

A command button is provided to access T.D.O.T. Design Division MicroStation 
Basic macro which is used to set any standard text size based on scale (command 
button: Alternate STD Text Size). 

A command button is provided to access the Place Label with Leader Line vba 
program. 

Since cross sections use a separate level structure from the rest of the T.D.O.T. 
Design Division DGN files, a special version of this program is provided named XS 
Text Styles Plus. 
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Place Label with Leader Line 
This program places general labels with leader lines. Options include 1 or 2 lines of 
text, horizontal line and choice of terminators including arrowheads or a dot. The 
current active scale is shown with a keyin field to reset as needed. Scale is used to 
control the terminator cell scale when included. Graphics are  placed at the current 
active level, symbology & text parameters. All label graphics are combined in a 
graphic group for easy movement or deletion. 

The most efficient use of this tool is in conjunction with the Text Style Plus vba 
program which will set the active level, symbology & text parameters. A command 
button is provided to access this program. 

ALL options on the dialog can be adjusted on the fly as the label is placed. 

This tool can be used without the placement of text to simply place a leader line. If a 
horizontal line is included without text then the length of the line is set at 10 character 
widths of the current text size. 

28




Label Station / Offset 
This program places a station and offset label based on a data point, or a station and 
offset keyed in by the user with the Geopak job number and chain name.  Options 
include title text, line separating station and offset, leader line and choice of 
terminator including arrowheads or a dot.  The current active scale is shown with a 
keyin field to reset as needed. Scale is used to control the terminator cell scale when 
included. Graphics are placed at the current active level, symbology & text 
parameters. All text and the divider line are combined in one graphic group and the 
leader and terminator combined in another.   

The most efficient use of this tool is in conjunction with the Text Styles Plus vba 
program which will set the active level, symbology & text parameters. A command 
button is provided to access this program.  

Label can be placed as a flag or perpendicular to the horizontal alignment. 

Perpendicular to Chain Horizontal with View 

After using this tool, the job number  and chain name are remembered and will be 
used to populate those fields when the dialog is opened again as long as the 
previously defined job number is found in the current active folder. 

This tool can be used simply as a horizontal alignment tracking device with dynamic 
mode without placing labels. 
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Rotate Fence/Selection Set Horizontal 
This program is much like the old command but now rotates fence contents or 
selection sets horizontal to the view based on 2 points which define the desired 
horizontal. One other change in functionality, graphics in a fence are shown 
dynamically during rotation to make it easier for correct placement by the user. 

A fence or selection set must be active at the time the command is accessed. If both 
are present then the fence is processed 

This is an alternative to the Rotate Element to Horizontal vba program for groups of 
un-associated elements as well as for element types not supported by that command. 

Measure Area and Annotate 
The main change from the old program is that users are no longer restricted in the 
ways in which the area can be calculated.  Any method available with MicroStation’s 
Measure Area command can be used. Once you are satisfied with an area that has 
been calculated, simply click on the Place Area Text button to place the area text 
label. Area text is given in square feet & acres for English files and in metric files it is 
given in square meters, square feet, hectares & acres. 
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Other New Tool Dialogs 
Most tools include prompts which will appear in the message fields on the Status Bar. 
Others also include dialogs for users to enter control values and settings. 
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6. Geopak 
The Geopak Road training manual for T.D.O.T. Design Division personnel, 
TDOTGEOPAKRoadCourseGuide.pdf, has been updated for V8 and now follows 
our standard workflows more closely. That document, along with the class files, are 
available from the CADD V8 web page at 
http://www.tdot.state.tn.us/Chief_Engineer/assistant_engineer_design/design/v8/v8design.htm 

Symbology Control Settings 

Several symbology control areas now make use of a symbology display window. 
Double clicking in the window opens the Geopak Set Feature dialog. 

NOTE: Due to the way this functions within Geopak, if you open a file which does 
not include the level that is specified, the level is automatically changed to the 
Default level. To avoid this problem, simply close cross section dialogs before going 
to non-cross section DGNs or avoid checking your pattern line settings under the 
working alignment while you are still in the cross section DGN. 

Working Alignments 

In the Define dialog of Working Alignments there has been one change. Under 
Pattern & Existing Ground there is now a separate symbology set up for 
Placement. The symbology controls shown in the dialog are used for search 
functions when trying to find the items. The symbology review window identified as 
Placement controls the symbology if new instances of these items are placed. For our 
workflows both symbology set ups would be the same usually. 
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COGO 
New Navigator Icon 
All icons for navigators throughout Geopak have been changed to this icon.  

Dialog Icons 
Several of the icons on the COGO dialog have been revised but except for COGO 
Navigator icon they really haven’t changed dramatically.  

All element list, print, delete commands have been combined onto element Utility 
tools including:  Point Utility, Curve Utility, Line Utility, Chain Utility, Parcel 
Utility, Profile Utility. Their new icons are the ones with the hammer. 

Note: Most Design Division users use COGO Navigator to do these functions, so if 
you would like to remove the Utility tools from the icons shown on the COGO dialog 
go to View>Icons>Customize This Group and click off the Element Utility options. 

Also now available from the COGO dialog are direct connections to the accuracy 
settings in user preferences for Distance and Angle values. 

Print from Output Window 
You can now print directly from the COGO output window. Select what you want 
printed or right click and choose Select All and then right click and pick the Print 
option. 
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Horizontal Alignment tools 
Place P.I. Alignment 
The new Place PI Alignment tool enables the user to create, review, or modify PI 
based alignments in a table format. The various fields in the table can be manually 
changed. New PI points can be added. Existing PI points can be moved or deleted. 
 Another tool removes curve overlaps. During a session the PI alignment is shown 
dynamically on the screen. 

Curves can be modified with several dynamic options: 

• dynamic PI location 
• dynamic pass thru point 
• curve / spiral properties 

Tangents can also be modified in several options: 

• direction 
• distance 
• distance tangent segment 

To access this new tool open the Horizontal Alignment tool menu. From the drop 
down it’s Applications>Geopak Road>Geometry>Layout Alignments 
Horizontal. 

This tool does not modify existing curves & spirals. When these are changed and 
the alignment is saved, new curves are created. In fact, even if they are not changed, 
saving the alignment will cause them to be recreated. Points & Chains are 
modified/re-defined. 

Set PI Alignment Preferences 
Under drop down option File>Preferences first set the COGO Element names 
which will be used for new elements created. At this time, the Place PI Alignment 
tool does not use the values shown for curves and spirals. Rather it uses the chain 
name and adds _(#) to name curves.  
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Second set the PI Alignment preferences. The most critical of these settings is the 
Station Method. It’s options include: 

Preserve PI Stations 	 Not recommended for our work in most cases. 
Whenever any modification is made, equation points 
are generated after all curves. 

Restation from 0.0 	 Recommended for new alignments and modification of 
existing alignments. 

Restation from Beginning Station This setting can be used when saving your 
new or revised alignment.   

If you are getting ready to use the Place PI Alignment tool set Station Method to 
Restation from 0.0. 

Under Geometry Settings make sure the following settings are made. 
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Place P.I. Alignment Dialog 
To access this new tool go to the drop down option Tools> Alignment. This will 
open the Alignment tool bar. Place PI Alignment is the icon showing a PI with sub-
tangents. 

The following list describes the icons/commands available across the top of the 
dialog. 

Select Chain from list ,or by the icon, graphically pick the 
chain / alignment.  Click icon, then select one element of a visualized chain. 

After the chain has been specified, clicking this button loads the chain into the 
list box. 

Load Graphic Element to Table, allows the user to pick a graphic element to 
build an alignment from. This data will replace any data currently in the list 
box. Examples might be a line, line string, arc or complex chain. 

Saves the chain. 

Insert a PI Point - Highlight a PI or tangent line in the list box, then click. This 
creates a new PI with the same values as the one before it and should always 
be followed by data pointing its location in the MicroStation view. 

Delete a PI Point - Highlight a PI line in the list box, then click. 
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Clear Alignment Table – Be Careful ! this clears the list box completely.  

Move Element - click and dynamically move the highlighted alignment 
element 

Modify Curve Radius - click and dynamically set curve radius. 

Check Overlaps - If two curves or spirals are overlapping, the overlap is 
removed. 

Undo & Redo. During modification of an alignment the dialog might need 
to be “refreshed”. Just click Undo and then Redo to re-display table values  

When using this tool to set up a new chain, the first PI will have the coordinates 0,0 
or if other alignment work has just been done, perhaps the coordinates from the last 
PI change. Due to this oddity it is recommended that you ignore this PI and when 
setting the next PI, set it at the true beginning of your alignment and go on from there. 
When all PIs are set, click on the line for the first PI which is not needed and click on 
the Remove PI button. You could edit the coordinates or try to move it but this work 
around seems the simplest.  

New chain set up in progress, notice there is no chain name or station values … 
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Nothing is written to the GPK file until you click on the Save button. Since this 
tool recreates the curves each time the alignment is saved, it is recommended that you 
avoid saving excessively. When you click the Save button, the Save Chain As … 
dialog is opened. Enter the chain name, beginning station value and click OK. COGO 
commands are generated and processed in the COGO dialog. 

After saving, Place PI Alignment dialog is updated with chain name and station 
values. 

When the Place PI Alignment dialog is closed, the temporary display in graphics is 
removed. Use D&C Manager to display permanent graphics.  
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 Design & Computation Manager 
The database for D&C Manager has been expanded with several new categories. 

Symbology control for graphics drawn with MicroStation tools are now only 
available from D&C Manager. 

Place Influence 

Place Influence now includes option to apply symbology to New Element Only. This 
will prevent accidental changing of graphics already in place. 
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T.D.O.T. Design Division Special Functions 

All MicroStation visual basic applications and MicroStation Basic programs 
developed for T.D.O.T. Design Division personnel are now available from D&C 
Manager. 
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VA Labeler 
This program was designed to label pertinent vertical alignment information on the 
profile. The user has the ability to choose the options they would like to label by 
selecting the check box corresponding to the label.  Chain, reference datum, and scale 
information is attained when the user selects the Geopak profile cell.   

Only profiles applicable to the identified Geopak profile cell are offered for labeling.  

Type option allows for application for roadways, private drives or special ditches. 
The type controls text sizes, orientation and symbology. 

Grade labels are placed on sub-tangents and tangents as well when vertical curves are 
separated by sufficient distance to warrant additional text placements. 

A Maximum Speed Label keyin field is provided. When set, all curves exceeding the 
given speed are labeled with the speed and a “+”. Any vertical curves where the speed 
is less than this value will also display a warning message as well. 

Program is set up for use on English or Metric projects 

All D&C Manager items which display proposed vertical alignments/profiles, such as 
VA Roadway, now place linework only. All annotation is placed by the VA Labeler 
tool. 
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Draw Profile Grid 

This 3PC program has been expanded to place station & elevation labels. The Exist. 
Ground item no longer places those labels.   

Easement Items 
The Drainage Esmt & Const Esmt items have been upgraded to Draw Plan & 
Profile type items so that they can be labeled automatically with distance and bearing 
when stored in the project GPK file. 
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Pay Items & Compute Mode 

Several new groups of pay items have been added. The ROW Markers item now can 
be used in Compute mode to calculate total quantities as well as its previous function 
in Design mode to compute quantities per sheet area. 

After quantities are calculated, results are now shown in the Computation Results 
dialog. From there output files can be created. Our standard Estimated Roadway 
Quantities Excel file now includes a macro to import item quantities saved to CSV by 
Item.   
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 Cross Sections 
The generation of existing and proposed cross sections have not really changed for 
the user. One thing to note though, is that proposed cross sections now run much 
faster than on previous versions! 

Update Project Criteria Files 
This new program is for use when new versions of cross section criteria files are 
downloaded from the web and project criteria files need to be updated. After 
downloading the new files to the standard criteria folder this program is used to copy 
the new versions to your project folder to replace/update individual criteria files or all 
as needed. 

In conjunction with the conversion of V7 project data to V8, this tool will be used to 
update all project criteria files to the new V8 versions.  

This tool is available from the MicroStation menu bar at  
TDOT > Cross Sections >  Update Project XS Criteria Files 
or from Geopak’s D&C Manager at  
Drafting Standards > Cross Sections > Update Criteria 
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Cross Section Sheets 
Geopak’s Cross Section Sheet layout tool has been completely re-built. The tool now 
attaches each cross section as a reference file. As long as no major changes in the 
proposed profile are made, any updates done to the original working cross sections 
will be automatically reflected on the sheets. 

 Before setting up cross section sheets open up the working cross section DGN file 
and use the level filter Sheets – Roadway Cross Sections or Sheets – Culvert Cross 
Sections to set the levels in view 1. Save Settings for the DGN file. This will ensure 
the correct levels are showing in the cross section reference attachments. 

We now have 4 cross section sheet libraries available for cross section sheet 
production. These files make all non-project specific set ups. 

Attach any of these by using the drop down option File > Sheet Library > Attach 
and navigating to the Design Division GeopakStandards folder, C:\Program 

scale culvert cross section sheets. 

Files\GeopakStandards. 
   Roadway10scale.xssl Cross section sheet library with settings to produce 10 

scale roadway cross section sheets. 
   Roadway20scale.xssl Cross section sheet library with settings to produce 20 

scale roadway cross section sheets. 
Culvert10scale.xssl Cross section sheet library with settings to produce 10 

scale culvert cross section sheets. 
Culvert20scale.xssl Cross section sheet library with settings to produce 20 

After making all project specific set ups, you can save this as a new cross section 
sheet library in your project folder for later recall. 
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We now have the ability to add a prefix and suffix to earthwork end areas. 

An option is also available to place additional sheet labels. The standard cross section 
sheet libraries set up basic project data labels for the upper right of the sheets as well 
as station limits and a name label for the lower right corner. On culvert cross section 
sheets the standard corner title block is set up at the lower right corner. 

This tool now places cross section sheet cells as well. They are set up by default to 
place as shared cells in order to limit the file space required for large numbers of 
cross section sheets. Due to this fact, plot borders will need to be placed using the 
Place and Annotate Cross Section Sheets tool described on the next page. 

Refer to chapter 16 in TDOT GEOPAK Road Course Guide.pdf for the new cross 
section sheet generation workflow and more specific details of its use.   
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Design Division Cross Section Sheet Tool 

This program places shared cross section sheet cells, plot borders and annotation as 
requested by the user on cross sections sheets set up by Geopak. All graphics are 
optional. The main use of this tool is to place plot borders and additional project data 
annotation after setting up the sheets with Geopak. 

Graphics and annotation can be placed for either roadway or culvert cross section 
sheets. Individual parts of Project Data annotation are optional as well as placement 
on either line 1 or 2 in the project data block.  

Separate graphic groups are set up for sheets, plot borders, project data annotation & 
title annotation to allow easy deletion and replacement as needed. 

This tool is available from the MicroStation menu bar at  
TDOT > Cross Sections > Place and Annotate XS Sheets 
or from Geopak’s D&C Manager at  
Drafting Standards > Cross Sections > XS Sheets 
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Plan/Profile Sheets 
Split Plan Sheets 
In the previous version of the software, the Plan Sheet Layout tool would only set up 
split plan sheets with consecutive stationing, such as top: 10+00 to 23+00 & bottom: 
23+00 to 36+00. 

That has changed with the new software so in our standard plan sheet library, 
tdot.psl, the split plan sheet set up, PLNPLN, has been revised to reflect the same 
stationing on top and bottom. This sheet set up can now be used when creating plan 
sheets for erosion control and traffic control which show different phases on top and 
bottom. 

Profile Stair Stepping 
The Plan Sheet Layout tool now supports profile stair stepping which is needed on 
roadways with extreme elevation changes across a given sheet. To apply this 
functionality, go to the drop down option Settings > Sheet Layout to turn it on. 
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New Plan Sheet Naming Convention 

With this software implementation, we are changing the naming convention for all 
sheet design files except cross section sheets to be the sheet number only, with “0” 
prefix as needed to sort alphabetically, without the project info prefix used on other 
DGN files. 

This has been done for several reasons including: the project will be very easy to plot 
in order when using batch plotting functions, so the project plan sheets can be 
published to Digital Interplot correctly and so other divisions, such as Right-of-Way 
and Construction, can use our files more efficiently. 
Examples:   Sheet 4 > 004.SHT , 

Sheet 4A > 004A.SHT 
Sheet 24 > 024.SHT 
Sheet 24A > 024A.SHT 

The Plan Sheet Layout tool now has the capability to do this automatically when 
generating plan sheets. On the Clip Sheets dialog enter square brackets with 3 
asterisks for the sheet number , [***] , followed by a suffix letter if needed and .sht 
for the filename extension into the Sheet Name Prefix keyin field. 

The example dialog below shows the set up when creating present layout sheets. For 
proposed layout sheets the format would be [***]A.sht. 

Refer to chapter 19 in TDOT GEOPAK Road Course Guide.pdf for the plan sheet 
layout workflow and more specific details of its use.  
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Geopak Drainage  
Several of the various dialogs within Geopak drainage have been rearranged but still 
contain the same data, etc. The TDOT GEOPAK Drainage Course Guide is 
currently under revision to reflect these changes. The information on the next 2 pages 
reflect the more significant changes in the way it functions. 

New Drop Down Menu 
When Geopak Drainage is first activated, the Drainage drop down menu is added on 
the MicroStation menu bar. 

To use the floating menu bar as we did with Geopak 2001 (V7) … 
The floating menu bar is minimized by default when Geopak Drainage is started. 
Move the view window so that you can see it minimized at the lower left and double 
click on it to open up. 
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Profile Displays 

In the previous version of Geopak Drainage profiles were called Reaches. In V8 they 
are now called Profiles! Along with this change, the dialog has been revised.  

The most significant change is the control of profile displays. Those are now 
controlled in the Profile dialog instead of Preferences as it was previously. You can 
also save these profile preferences to use later as needed. A standard profile 
preference file has been developed named TDOTStormSewerProfiles.ppf. 

To load a profile preference file go to the drop down option File >Open. 
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Profile structure display controls. 

Drainage design control element displays. 
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Grids and Labels display control. When you pick each data type option in the list to 
the left, its control settings are shown. 

The screen capture below shows the default display from standard profile preference 
file TDOTStormSewerProfiles.ppf. During the design process you may wish to turn 
other options on. For the final displays for the plans you may wish to turn some text 
options off. 
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7. Office 2003 to MicroStation V8 
For the users there aren’t significant changes in the way Office files are linked to 
MicroStation but the way it works has changed. In the past MicroStation graphics 
were generated to represent the text and lines from those files. Now it is truly what 
you see in Office is what you get in MicroStation.  

Wide Excel blocks, such as R.O.W. acquisition tables, no longer have to be linked in 
more than one piece. 

Linking values for Excel and methods for attaching Word documents have changed. 
For complete documentation on workflows, etc. refer to 2ndSheetsV8.pdf and 
ROWAcqTables.pdf. 

New Formatting 
Due the changes in the way this process functions, it is no longer necessary for us to 
use the fonts and other settings as done previously with MicroStation J (V7). Arial is 
used in most cases which makes the Office files much easier to read and work with. 
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Office Links 

When Office files are linked to MicroStation they appear with a white background 
and are bounded by a shape which they are defined in. The shape can be moved and 
copied. The link shape is created on the level active at the time the Office file is 
linked to MicroStation. 

Linking in Rotated Views 
There is no longer any limitation to linking Word or Excel files into rotated views. 
When they are linked they always come in horizontal to the view. This eliminates the 
previous need to link and then reference to get notes or R.O.W. acquisition tables to 
show up on property map sheets. 
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